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Using Query Manager 
The steps used to create a query in EMACS version 9.0 are very similar to creating a query in the 
previous version of EMACS, version 8.3 

Before you can create a new query, modify an existing query, or run a query, you must navigate to the 
main page of Query Manager, as shown below. 

 

Navigate to query manager: 

1. Main Menu > Reporting Tools > Query > Query Manager 
As you drill down through the different levels to get to Query Manager, the Menu and navigation path 
remains visible on the left side of the page.  If you wish, you can collapse the Menu by clicking the small 
minus sign on the menu bar.  A small 'expand' icon will remain in its place. The path refers to the 
navigation steps you’ve selected for each specific menu group, menu, menu item and component. 

 

 
 

The Find an Existing Query search page is displayed.  From this page, you can either create a new 
query or find an existing query. 

Public Queries can only be run, not deleted or modified.  You can, however, take a public query, modify it, 
and then save it as a private query.  You can run, modify and delete your Private queries. 

Click to collapse menu 
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Creating a new Query 
To create your query, you will define the relevant parts of your query within Query Manager.  Query 
Manager provides a page that corresponds to each part of your query provided by tabs 

• Records – select tables 

• Query – select fields 

• Fields – view fields 

• Criteria – define and view criteria 

• Properties – refine output  

To begin defining a new query, you would select Create New Query from the main page of Query 
Manager. Because the first step in creating a new query is to select the record upon which the new query 
will be based, Query Manager takes you directly to the Records page so you can select the base record. 

We will use the JOB – EE History record to build and modify our queries. 

 

To select a record for the query: 

1. Click the Create New Query hyperlink to jump to the Find an Existing Record search page. 

a. You can find an existing record (table) by entering the record name or partial name in the blank 
Search By field then clicking the Search button.  

b. If you leave the field blank and click the Search button, a list of up to 300 records will be 
displayed. 

c. By default, only the first 20 records appear on the page. To see more of the list, use the 
navigation buttons and links located on the header bar. 

 

 
 

Click to expand menu 
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2. Leaving the Search by: Record Name field at its default value, enter a partial name of JOB in the 
blank field, and click the Search button.  

 

 

For each page displayed, Field Descriptions have been given as reference material.  

'Find an Existing Record' Field Descriptions 

Query Name This field is read-only. The default "New Unsaved Query" is displayed until 
query is saved. This field is displayed on all the Create New Query pages. 

Description This field will be blank until query is saved. 

Record The name and description of the records to which you have access are listed. 

View All Click View All link to view all the records found. You may have to scroll 
through many records to locate your desired record. 

 
Use arrow to move to the next 20 records 

Last Click Last link to move to the very bottom of the list. 

"Add Record" link Click the Add Record link to select the record.  You’ll be dropped into the 
Query page where you can add fields to the query or add additional records. 

Show Fields Click Show Fields to open a view of fields for the record.  Click the yellow 
Return button to go back to the list of records. 

 

3. Click on Add Record on the JOB – EE History row to select the record. 
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4. The following message appears as a reminder.  Effective Dating will be covered in a later section.  
Click OK. 

 

 

You are automatically dropped into the Query view - Query Tab - to begin selecting fields. 

'Query Tab' Field Descriptions 

   Click the Folder to hide or show the list of fields associated with the record. 

Alias Record The system-defined name and description assigned to the chosen record(s) is 
displayed. 

Hierarchy Join Click the Hierarchy Join link to join a child table to its parent table 

Related Record Join Click the Related Record Join link to join two records based on a shared field.  

• For example, in the next screenshot the JOB record is related to the 
JOB CODE record by the JOB CODE field 
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Query Field Descriptions (cont) 

Check All Fields Click the Check All Fields button to select all fields in the record. 

Uncheck All Fields Click the Uncheck All Fields button to uncheck all fields in the record. 

Fields Select the box located to the left of each field that you wish to add to your 
query.  Click again to de-select. 

Indicates key fields.  Using key fields in criteria will help your query run 
more efficiently. 

 
Click the Use as Criteria link to add a row of criteria for the selected field. You 
are taken to the Criteria page where you can complete the criteria for the 
selected field. 

 
Click the Delete button to delete the associated record from the query. 
A confirmation message will appear. Click the Yes button to proceed with the 
deletion. Click the No button to cancel the deletion. 

 
After the record has been selected, the next step is to select the individual fields from the record that you 
want in your query results. 
 

To select fields for the query: 

1. Click the checkbox next to each field you want to include in the query output.   Click on:  EMPLID, 
EMPL_RCD, DEPTID, JOBCODE and EMPL_STATUS.  

 
After you have selected the fields for output, you need to define the criteria.  Criteria tells Query Manager 
what data to select based on defined values.  To build the criteria, select a field and then define what the 
field's value should be.  Query will pull all data that match the criteria. 

As with other Query functions, there are two ways to enter criteria.  You may enter criteria from either the 
Query page or the Criteria page.  Entering criteria from the Query page is much faster than using the 



County of San Bernardino 
Private Query 

Transition Training 
 

 

 
October 2010 - Page 6 - 

Criteria page so it is demonstrated below.  Using the Criteria page will be explained in the Advanced 
Function section. 

Note: EMACS is case-sensitive.  Some entered data will convert to all caps, however, when defining 
criteria in Query, your constant values need to be entered in ALL CAPS.  For example, in our sample 
query using the JOB table, the employee status we want should retrieve only Active employees.  The 
entered criteria, your constant value, should be entered equal to ‘A’ not ‘a’. 

 

To enter and edit selection criteria from Query page: 

1. On the JOBCODE row, click on the funnel   to select this field. 

 
You are linked automatically to 'Edit Criteria Properties' to further define the criteria. 

 

'Edit Criteria Properties' Field Descriptions 

Choose Expression 1 
Type 

Field.  The value you want to base the selection criterion on. To compare the 
values from fields in two records, you need to join the record components. 

Expression.  Advance functions that will not be covered. 

Expression 1 A field component on which you want to base the selection criterion. 

*Condition Type Select the condition type from the drop-down list. 

Choose Expression 2 
Type 

Field.  Another field's value, usually a field in another record component. To 
compare the values from fields in two records, you need to join the record 
components. 
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'Edit Criteria Properties' Field Descriptions (cont) 

Choose Expression 2 
Type 

• Expression.  An expression you enter which Query evaluates before 
comparing the result to the value in the selected field. Query evaluates the 
expression once for each row it tests. 

• Constant.  A single fixed value. 

• Prompt.  A prompt value. 

Expression 2 
 

Based on the expression 2 type you selected, this box is where you specify the 
Field name, Expression, Constant value or Prompt for which query will look. 

Define Constant If you selected 'Constant' as your 'Expression 2 Type', this is the value query 
will look for. 

 

2. Leaving all fields at their default values, in the Expression 2 box, in the Constant field, enter the job 
code 01025.  Click OK.  You will be returned to the Query page to finish selecting criteria. 

a. If you did not know the job code, you could click on the magnifying glass in the Expression 2 box 
and Query would bring up a list of valid job codes from which to choose.  From the list, scroll to 
find the job code, then click on the Select Constant link.  

b. If the list has too many possible values, query will return the message ‘No matching values were 
found.”. 

3. Repeating steps 1 and 2, add as criteria, the following fields and values: 

a. EMPL_STATUS equal to A (A translates to Active).  Remember to use capital ‘A’. 

b. SHIFT equal to 1. 

4. Click on the Criteria page to view completed criteria. 

 

Notice that the first field selected as criteria is EFFDT – Effective Date.  Since the record JOB is an 
effective-dated record, Query assumes you want the most current date so this criteria is already selected.  
Certain tables in EMACS carry with them effective dates which tell EMACS when certain actions or 
events take effect. 
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This Effective Date field gives a historical perspective allowing you to see how the data has changed over 
time.   When using effective dated tables, you usually want the most current effective row of data—that is, 
the row whose EFFDT value is closest to today's date without being in the future. You may not want to 
view the history rows which may no longer accurate nor do you want to see future-dated rows.  However, 
you do have the ability to see these rows by changing the criteria for the effective date.  This will not be 
covered in this document. 

Since we do not really care about shift, we’ll delete the criteria row of shift. 

5. To delete a criteria row, click on the minus sign (Delete column) on the Shift row. 

View after Shift row deleted. 

 

 

To edit field properties: 

With edit properties, you have the ability to change field length, change headings, change sort order, sum 
amounts, etc.  Before we run the query, we want the output to be sorted by employee id. 

1. Click on the Fields Tab. 
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'Fields Tab' Field Descriptions 

 
Click the Reorder/Sort button to change the order in which columns appear or 
to specify a sort order. 

Col (Column) Displays the column order for each field listed. 

Record.Fieldname Displays the name for each field listed. 

Format Displays the field type and length for each field listed. 

Ord Shows one or more fields selected to sort your query output. 

• If the field is the first sort field, a 1 appears, and the system will sort rows 
based on this field first. The second sort field selected will be numbered 
2, and so on. 

• You can also specify a descending sort order. The letter D will appear if 
selected. 

XLAT Specifies which translate value you want to display in the query results: None, 
Short, or Long. 

Agg Displays the aggregate function for each field listed. 

Heading Text Shows the heading assigned to display at the top of the column for the query 
output for each field listed. 

 Click the funnel to add a row of criteria for the selected field. You are taken to 
the Criteria page where you can complete the criteria. You can also add 
additional criteria. 

 
Click the Edit button to format the query output. For example: change column 
headings, use aggregate functions, display translate table values in place of 
codes,etc. 

 Click on the Minus button to delete the associated field from the query. 

2. To sort the output by employee ID and then by Department ID, click the Reorder/Sort button. 

3. In Edit Field Ordering, in the 'New Order By' box, enter 1 and 2 on the EMPID and DEPTID rows. 
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'Edit Field Ordering' Field Descriptions 

New Column Query Manager adds the columns in the order you select the fields. To change 
the order, enter the new column number here. When you close the Edit Field 
Ordering window by clicking OK, the columns are reordered. 

Column Indicates the order of the columns before you opened the Edit Field Ordering 
window. 

Record.Fieldname Displays the names of the fields you have selected. 

Order By Indicates the sort order of the field(s) by which data will be sorted.  When you first 
open the Edit Field Ordering window, this field will be blank. 

Descending Check the box to sort data output in descending order. Leave blank to sort in 
ascending order. 

Order By Number To sort data output, enter the column number for the field you wish to sort by. 

 

4. Click OK. 

 

Notice the 1 and 2 in the Ord column. 
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5. To change Heading Text and Translate Value, click on the Edit button on the EMPL_STATUS row.  
The Edit Field Properties window will open. 

 

 

6. In the Heading section, choose heading type Text and type in "Employee Status" in the Heading 
Text box.  In the Translate Value section, choose a Long translate value. 
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Edit Field Properties Field Descriptions 

Field The name of the field for which you are editing properties. 

Heading Choose column heading from the following: 
• No Heading. The column does not have a heading. 
• Text. The column heading is the text you've entered in the text box. 
• RFT Short. The column heading is the short name from the record 

definition. 
• RFT Long. The column heading is the long name from the record 

definition. 

Heading Text Text displayed at the top of the column. 

*Unique Field Name Used for translations. There is no need to change this field. 

Aggregate To aggregate values, select the aggregate function value for this field: 
• None. No aggregate functions used. 
• Sum. Adds the values from each row and displays the total. 
• Count. Counts the number of rows. 
• Min. Checks the value from each row and returns the lowest one. 
• Max. Checks the value from each row and returns the highest one. 
• Average. Adds the values from each row and divides the result by the 

number of rows. 

Translate Value To select a translate value, choose from the following: 
• None. Result will be a one character value, (i.e. 'L' for 'Leave Status') 
• Short. Result will be a short name ('Leave' instead of 'L')  
• Long. Result will be a long name ('Leave with Pay' instead of 'L') 

Other editing can be done from here, such as summing an amounts field, changing the system-defined 
heading to one of your own, or changing the translate value of a field. 

7. Click OK. 

 

Notice the XLAT value has changed from N (none) to L (long) and the Heading Text now reads 
"Employee Status" rather than "Pay Status". 
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Saving a Query 
You can save a query at any time after you have selected one record and at least one field.  You do not 
have to save a query before you run it, but to avoid losing your work, it is best so save your query 
periodically as you build it.  If you modify an existing query, you may wish to save the new query under a 
different query name so you won't lose your changes. 

To save a query: 

1. Click on the Save As link. 

2. Enter the *Query Name of Active_Emps.  Enter Description as Active Employee. 

Note. An asterisk before a field name indicates that it is a required field and must be completed.  Query 
name is required, however, description is not. 

 

 

“Save Query As’ Field Descriptions 

*Query Name Enter the name of the query 

Description Description of the query.  Limited to 30 characters. 

Folder: Enter the name of the folder in which you would like the query to reside.  To 
create a new folder, enter the name of the new folder. 

*Query Type This field is read-only. 

*Owner Choices are usually Private or Public.  You will only have the capability of 
building private queries. 

Query Definition Free text that can be used to further describe your query. 
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3.  Click OK.  You are once again returned to the Records page. 

 

 

 

Notice that the Query Name is now ACTIVE_EMPS whereas before it was New Unsaved Query. 

Using Save As creates an instance of the query that you created or if you modified an existing query, it 
creates another instance.   Save simply saves over the current query. 

 

Run a Query 
To run a query: 

1. Click the Run tab at the top right of the page.  

The query results will be displayed. 
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Download the Query as an Excel Spreadsheet or CSV file 
Once your query has been run, you can of download your results to an Excel spreadsheet or a CSV file. 

To download to Excel 

1. Click the hyperlink Download to Excel (see page 14) to open the file in your browser in Excel.  
The following message appears.  Click on Open. 

 
 

When you download to Excel, a new Excel window will open in your browser. 
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Working in Excel through the browser allows only minimal Excel functions to be performed like basic 
formatting and sorting. 

If the Excel application is on your PC and you need more advanced Excel functions, you can save you 
query results in an Excel format and retrieve the document through Excel.  To save as an Excel file: 

1. Using the browser menu, click on File then Save As. 

2. At the save as box, navigate to the location and folder in which you want to save your file. 

3. In the 'Save as type' box, click the drop down arrow and select Microsoft Excel Workbook. 

4. At File name: enter Active Employees and hit Save. 

You may now open up Excel and retrieve the worksheet. 

 
To download to CSV test file 

If your individual PC has Excel and your CSV default is set to Excel, you can download to CSV text file 
which will open the Excel application and all functions and formatting will be available. 

1. Return from Run to another page of Query and Click the Return to Search button. 

 

 
 

2. On the Find an Existing Query page, type in 'Active' and Click Search. 

3. Find your query ACTIVE_EMPS and on the same row click on the HTML link under Run to HTML.  A 
new window will open with your results and two Download options will be available: Excel 
Spreadsheet and CSV Text File. 
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4. Click on CSV Text File. 
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5.  The following message will appear.  Click on Open. 

 

 

5.  A new Excel window will open. 

 
 

If you click on CSV Text File and Excel does not open, your default CSV needs to be changed to point to 
Excel.  Your internal computer operations section should be able to make the change.  
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Note that from the query search page you may also run your query to Run to HTML which opens a new 
window with the query results.  From this page, which resembles the 8.3 version of query, you can 
download to Excel or CSV Text File.  From the search page you can also click on the link Run to Excel 
and Excel will open through the browser window. 

 

 
 

 

 

Print a Query 
To print query results: 

1.  If you are in Query Manager and used the Run tab to get your results, you’ll need to Download to 
Excel first.   

2. Once your results are in the browser, click on the Printer icon or navigate to File > Print in your 
browser menu. 

 

NOTE: If you are in the Run tab of query and do File > Print, only a partial page of your results will print.  
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Exit Query Manager 
1. To exit, click on Home at the top of the page. 

 

 
 
 

Update an Existing Query 
There may be times when you'd like to update a query to reflect new conditions or copy an existing query 
and modify for other uses. You can open a query, examine it to see if it's suitable, modify as needed then 
use the Save As function to save it with a new name. 

To update an existing query: 

1. If you have exited query manager, navigate from Main Menu > Reporting Tools > Query > Query 
Manager 
If you are still in query manager, you may hit the Return to Search button that appears in lower right 
hand corner of most of the pages.  You will be taken to the Find an Existing Query page. 
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2. Enter ACT in the blank select box and click Search. 

 

 
 
From this page, you may run existing private or public queries.  You may also delete private queries by 
selecting the appropriate Action from the drop down menu. 

3. Locate and click on the ACTIVE_EMPS Edit link. 

 

 
You are dropped into the Fields page to begin modifying.  We will modify the criteria for the job code to 
retrieve several, specific job codes. 
4. Go to Criteria Page by clicking on Criteria. 
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5. Click the Edit button on the JOBCODE row. 

6. In the Edit Criteria Properties, in the *Condition box, hit the down arrow.  Scroll to find In List, 
highlight to select. 

 

 
 

7. In the Edit List in Expression 2 box, click on the magnifying glass to begin listing job codes.  When the 
following window opens, click Search. 

 

 
 

8. This window opens.  Click the magnifying glass icon next to SetID. 
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9. Click Look Up button when the following window opens.  Select COMMN from the list. 

 

 
 

10. Repeat step 9 for search for Job Code. 

11. At the following window, click Look Up. 

12. A list of Job Codes Appears.  Select 01025. 

 

 
 

13.  Click OK. 

 
 



County of San Bernardino 
Private Query 

Transition Training 
 

 

 
October 2010 - Page 24 - 

14. Repeat the steps outlined above and add job code 01059. 

 

Notice the previous entered job code 01025 appears in the List Members box.  If you needed to delete 
this job code, click on the check box and click the Delete Checked Values box. 

15. Click OK. 

 
 

16. Click OK in the Edit Criteria Properties box. 

17. Save query by hitting the Save button.  Run the query. 
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In the previously modified query, we used the In List Condition Type in Criteria.  We listed specific job 
codes to retrieve.  One other useful criteria condition is the wildcard %. 

If we edit the JOBCODE criteria by changing *Condition Type to ‘like’ and the Constant in Expression 2 to 
‘03%’, query will retrieve all rows where the job code begins with 03XXX. 

 
 

 
 
 

Run an Existing Query 
Run an existing query: 

1. Navigate to Main Menu > Reporting Tools > Query > Query Manager. 

Or if you are still in query manager, click on the Return to Search key. 

2. Enter SB_DEPT in the blank select box and click Search. 
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3. Locate SB_DEPTID and click on HTML or Excel to obtain a list of department ID'S and descriptions. 

 

Delete a Query 
To delete a query: 

1. Navigate to Main Menu > Reporting Tools > Query > Query Manager. 

Or if you are still in query manager, click on the Return to Search key. 
2. Leaving the 'begins with' field blank, click Search. 

3. From the list, select Query Name ACTIVE_EMPS by clicking its check box at the left.  Select 'Delete 
Selected' from the Action drop down menu and click Go 
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4. You will be prompted to confirm deletion. 

 
 

5. Click Yes to delete but for this sample, click No.  You’ll be returned to the Find an Existing Query 
page. 
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Advanced Query Functions   
Advanced functions include: 

• Add a prompt 
• Table joins 
• Distinct function 
• Building expressions 
• Unions using SQL 
• Sub-queries 
 

Building expressions, unions using SQL and sub-queries are beyond the scope of this class and will not 
be covered.  We will do the advance functions of adding a prompt and doing a table join but not the 
distinct function.  It is documented, however, for reference. 
 
 

Prompts 
Adding a prompt allows you to further refine a query when you run it. For example, retrieving employee 
information on different employees.  Instead of hardcoding an employee id in the criteria and changing it 
each time you run the query, you could add a prompt so each time the query is run, you can enter a 
different employee id. 

Use our existing Active_Emps query, we will be adding a prompt for the Job Code so we can run the 
query for different job codes. 

1. If you are still in Active_Emps, do nothing.  If you are not, retrieve the query ACTIVE_EMPS.   
Click on the Return to Search button. 
Enter ACTIVE_EMPS as the search criteria. 
Click SEARCH button. 
Click on ACTIVE_EMPS query. 
The Fields page is automatically displayed.  We will be entering the prompt as criteria.  

 
2. Click on the Criteria page. 
 

 
 

3. Click the Edit button on the JOBCODE row 
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4. In the Edit Criteria Properties box, select Condition Type "equal to" and under Choose Expression 2 
Type, click on the Prompt radio button. 

 

 
 
 
The Expression 2 box now opens an additional Define Prompt Box. 
 
5. Click the New Prompt link.  The Edit Prompt Properties box opens. 
 

 
 
   
 

Field Descriptions 

Field 
Click the button to select a prompt field. After you select a prompt field, it 
shows the name of the field. Query looks to the record definition for information 
about this field and fills out the rest of the dialog box based on its properties. 

*Type Select a field type from the drop-down list. 
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*Format Select a format for the prompt field from the drop-down list. 

*Heading Type Select the Heading Type from the drop-down list. 

Heading Text Displays the label for the text box where the user will enter the comparison 
value. To change the text, select Text from the Heading Type list box, then type 
the new label in the Heading Text box. 

*Unique Prompt Name A default value generated by Query Manager for globalization. This value can 
only be set by a base language user to uniquely identify a query prompt 
parameter. 

Length Specify the length of the prompt field. 

Decimals Specify the number of decimals to be used with the prompt field. 

*Edit Type Defines the type of field edit for the specified field. In general, we recommend 
that you use the same Edit Type that is used in its record definition so that it is 
consistent throughout PeopleTools. 

Prompt Table If the Edit Type is Prompt Table, the value in the list box specifies the prompt 
table to use. Only values in the prompt table can be entered.  If the No Edit 
Table is selected, query will accept all values entered all of which may not be 
valid. 

6. In dropdown arrow in the *Edit Type box.  Select No Table Edit.  Click Ok.   

When selecting the Edit type of Prompt Table, query sometimes may not find a value even though it is 
valid.  When the No Table Edit is selected, you must be careful that you do input a valid job code, 
otherwise you may get blank results due to an invalid job code and not due to no employees currently 
occupying that job code. 

6. In the Edit Properties box, click OK again. 

 

Notice Expression 2 has changed to :1. 

7. Save As ACTIVE_EMPS_PROMPT. 

8. Run the query. 
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9. Enter job code 06060 and click OK button. 

 

10.   You may Rerun Query to enter new values in the Job Code box. 

 

 

 

Joining Records  
Query Manager allows you to retrieve data from more than one table in a single query.  A join connects 
two or more table together by common values.   For example, within the Job View table, a join can occur 
with the Department table since the Dept ID exists in both tables, or join with the Job code table since the 
Job code field exists in both tables. 

We will only perform a related record join.  Using the existing ACTIVE_EMPS query, we will join the 
Department table to get the description of each department. 

 
Creating a Related Record Join 

1. Retrieve the existing query ACTIVE_EMPS. 

2. Move to the Query page.  Click on the join related record link Join DEPT_TBL_Departments. 
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3.  Click OK to select the Standard Join type. 

 
 

4.  Click OK to select the Standard Join type. 
 

 
 

5. At the 'effective date' message, click OK. 

6. Query will open the DEPT_TBL fields.  From the new table, click on the DESCR-Description field. 
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7. Save query as Active_Emps_By_Dept 

8. Run the query 

 

 
 
 
 

Properties – Distinct 
You can use the Distinct option to eliminate duplicate rows in a query result. Some queries will return the 
same row more than once because it satisfies the query in more than one case. The Distinct option 
removes the duplicate rows from the result set. For example, if two returned rows are identical in all 
selected columns, Query displays only one of the rows. 

We will not perform a distinct in this class, however, if you run upon duplicate rows, use the steps below.  

To do Distinct to eliminate duplicate rows 

1. In the query, click on the Properties link at the bottom of most query pages. 

2. Click on the Distinct box and  click OK. 
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3. Save query and run. 

 
Field Descriptions 

Query Name • The default "New Unsaved Query" is displayed until changed on the 
Properties page. 

• This field is displayed on all the Create New Query pages. 

Description • This field will be blank. A description can be entered on the 
Properties page. 

• This field is displayed on all the Create New Query pages 

Folder: Enter the name of the folder in which you would like the query to reside.  To 
create a new folder, enter the name of the new folder. 

Query Type This field is Read-only.  

Owner Valid value should only be Private.  Public would allow other users to run 
the query. 

Distinct Use the Distinct option to eliminate duplicate rows in a query result. 

Query Definition Free text area that can be used to further describe your query. 

Last Updated Date/Time The date and time the query definition was last saved. 

Last Update User ID The name of the last user to save the query definition. 
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Alternate way to enter criteria – From Criteria Page 
To enter and edit selection criteria from the Criteria page: 

1. After adding a record to your query (JOB_VW is used in this example), click the Criteria page to 
begin adding editing criteria.  For EFFDT, use default values. 

 

Field Descriptions 

Add Criteria Click button to add criteria. 

Group Criteria To select two or more fields to be compared with together.  An advance function 
that will not be covered. 

Logical Any rows after the first row must include either an AND or logical value to specify 
whether you want the rows to meet this criterion in addition to other criteria you've 
defined or as an alternative criterion. The first criterion you define doesn't have a 
value in this column. The default for subsequent criteria is AND. 

Expression1 EFFDT is automatically entered due to the record JOB being an effective dated 
table.  This is the field in which you want to base the criteria. 

Condition Type This operator describes the type of evaluation that query will use. 

Expression2 This is the value that query compares (using the condition type) to Expression 1. 
Can be one of up to five types of values, normally constant or prompt will be used. 

• Field 
• Expression 
• Constant 
• Prompt 
• Subquery 

 Click the Edit button to modify the associated criteria. 

 To deleted the current criteria row. 

 

2. Click the Add Criteria button to begin adding additional fields. 
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3. In the Expression 1 box, click on the magnifying glass.  This opens up the Select Record and Field 
window.  These are the available fields for selection. 

 
 

4. Scroll and locate A.JOBCODE field.  Click on the link to select.  Query drops you back to edit criteria 
properties. 
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In Expression 1 box, JOBCODE is selected. 

5. Leave *Condition Type: at equal to and also leave the Choose Expression 2 Type as Constant.  In 
Expression 2 box, click in the Constant field and enter the job code 01025.  Click OK button. 

 

Notice that JOBCODE is now another row in the Criteria page.  You may continue to enter additional 
criteria repeating steps 2 through 5. 
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